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Exploring Oracle Solaris 11 Express

Welcome to Oracle Solaris 11 Express. This documentation is intended to help you with the
installation and setup of the operating system and to make your initial experience with the
software a successful one.

If you are a new user, review the following information:

■ “Exploring the Oracle Solaris 11 Express Software” on page 8
■ “Exploring the Oracle Solaris Live CD” on page 11

If you are already familiar with the operating system, go to “Installing From the Oracle Solaris
Live CD – Quick Reference” on page 12.

Why Use Oracle Solaris 11 Express?
The Oracle Solaris 11 Express operating system (OS) offers a snapshot of features and
capabilities in Oracle Solaris 11. As such, you can use Oracle Solaris 11 Express to evaluate the
platform and prepare for future application and data center migrations to Oracle Solaris.

Oracle Solaris 11 Express includes, among other things, the GNOME Desktop Environment,
GNU tools, and a network-based software management system. The OS also includes
state-of-the art features: the Oracle Solaris ZFS file system, Oracle Solaris Dynamic Tracing
(DTrace) framework, containers for running applications in protected environments, and
advanced network virtualization capabilities.

Those who love technology, simply for technology's sake, will enjoy the many features that the
operating system has to offer. However, from a practical standpoint, these features are meant to
simplify, improve, and streamline your system management and application development .
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Some examples include:
■ Organizing and isolating workloads by using zones.
■ Leveraging Oracle Solaris ZFS for unprecedented scalability, reliability, and management

simplicity.
■ Using sophisticated network virtualization capabilities to maximize resource control,

network performance and utilization, utility computing, and server consolidation.
■ Managing system services through the Service Management Facility (SMF), a Windows-like

service management capability that supports managing service dependencies, service
startup order, and service failures.

■ Using the Time Slider feature of Oracle Solaris to easily browse and recover files from ZFS
backup snapshots, without the assistance of a system administrator.

■ Speeding up application development and debugging your system by using Oracle Solaris
DTrace, a tracing infrastructure feature that provides visibility into system performance. By
using built-in measurement points in the operating system, DTrace can display detailed
performance characteristics about the operating system or user programs that are running
in the operating system.

All of these capabilities are available through a simple installation. Alternatively, you can
explore Oracle Solaris on a live CD, without actually installing it on your system. Or, you can
run the OS in a virtual machine, for example VirtualBox or VMware.

Exploring the Oracle Solaris 11 Express Software
The Oracle Solaris distribution enables you to do the following:
■ Explore the operating system.

Oracle Solaris 11 Express provides a live CD ISO image for x86 platforms. The live CD ISO
image includes a basic, core operating system and the GNOME desktop. You can explore
the OS from the live CD, without actually installing it on your system. For more
information, see “Exploring the Oracle Solaris Live CD” on page 11.

■ Install the operating system.

There are several installation options to choose from, depending on your system's
environment and requirements:
■ Use the live CD ISO image on x86 based systems.

On an x86 based system, you can view the Oracle Solaris 11 Express operating system by
using a live CD ISO image, then install directly from that ISO image. (To install Oracle
Solaris on your system, you must first burn the bootable image to a CD.) Or, you can
download the live CD ISO image, and then install the OS in a virtual machine, directly
from this image.

■ Use the text installer for x86 or SPARC based systems.

Exploring the Oracle Solaris 11 Express Software
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For systems that do not have a graphic display, you can use the text installer.

Note – Both the live CD GUI and text installers are capable of running with a minimum
of 512 MB of memory. However, the minimum amount of memory that is required
varies, depending on system specifications. If the GUI installer on the live CD ISO image
does not work on your system, use the text installer.

■ Use the automated installer for x86 or SPARC based systems.

For installing multiple systems, use the automated installer, which provides simplified
setup and configuration for multiple installations of the operating system.

The automated installer enables system administrators to create an installation service
that provides blueprints for specific x86 and SPARC based installations. The installation
service includes a web server that stores manifest files with installation specifications that
are defined by the administrator. To locate an installation blueprint that matches
particular system specifications, clients can contact the web server and review the
available services by using associated manifest files. When a matching blueprint or
manifest file is found, the service installs the client with Oracle Solaris, according to the
specifications in the manifest file. Note that the automated installer does not include a
desktop or any interactive functions.

To download and install Oracle Solaris 11 Express, go to http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.
■ Add and update the software that is on your system.

After Oracle Solaris has been installed on your system, additional software packages,
including developer tools, can be downloaded by using the Image Packaging System (IPS).
IPS accesses software packages from networked repositories and then installs them on your
system.

IPS offers both the Package Manager graphical user interface (GUI) and command-line
utilities, such as the pkg command, to install and manage the software packages on your
installed system. Package Manager for IPS enables you to easily update and manage software
packages that are on your system directly from the desktop.

On an installed system, Package Manager can be started from the desktop by choosing
System → Administration → Package Manager. You can also start the application by
clicking the Package Manager icon that is located on the desktop.

Use Package Manager or the IPS CLI to perform the following tasks:
■ Add new software packages to your system from networked repositories.
■ Update the existing software packages individually on your system.
■ Update all of the software packages on your system at once.

Exploring the Oracle Solaris 11 Express Software
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Note – You can use Package Manager and the IPS tools to perform several other types of
tasks, including creating and managing boot environments, mirroring a repository, and
creating and publishing packages.

■ Set up a customized application development environment on your system.

Oracle Solaris offers complete support for developing and deploying applications. Tools that
are required for application development are available for download and installation
through Package Manager. You can easily download and install tools, such as compilers,
debugging tools, performance analyzers, NetBeans, source code management, and the make
utility.

You can also download and install Web Stack development tools, such as Apache web
server, Hypertext Preprocessor (PHP), Lighttpd web server, and the Squid caching proxy.
For more information, see Chapter 7, “Setting Up Your Application Development
Environment.”

■ Create and manage multiple boot environments on your system.

A boot environment (BE) is a bootable instance of the OS image, plus any other software
packages that are installed into that image. You can maintain multiple boot environments
on your system. Each boot environment can potentially have a different software version
installed.

With multiple BEs, the process of updating software becomes a low-risk operation, because
you can create backup boot environments before making any software updates to your
system. If necessary, you have the option of booting a backup boot environment. For more
information, see “Managing Multiple Boot Environments” on page 62.

Exploring the Oracle Solaris 11 Express Software
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Exploring the Oracle Solaris Live CD
Oracle Solaris provides a live CD ISO image for x86 platforms that boots to a minimal operating
system, with a GNOME desktop that includes the Firefox Web Browser, Thunderbird
Mail/Calendar, and other core applications, features, and tools, including the following:
■ The network auto-magic (NWAM) feature of Oracle Solaris, which is enabled by default

during an installation. NWAM enables you to monitor network activity and manage
network interfaces.

■ The Device Driver Utility, a tool that provides information about devices in your native
system and their corresponding drivers. This utility enables you to connect to the IPS
repository and search your system for any devices that do not have drivers attached to them.
When you boot your system from the live CD ISO image, and the desktop is displayed, the
Device Driver Utility automatically launches and begins searching for missing device
drivers. If the utility locates any such devices, a notification is displayed on the desktop. The
missing driver is then automatically installed on your system from the Oracle Solaris
repository.
To manually launch the Device Driver Utility from the desktop when exploring with the live
CD, choose Applications → System → Device Driver Utility.
If you are performing an interactive installation in text or console mode, a new “Install
additional driver” menu option is available on the startup menu. Use this option if you want
to start the Device Driver Utility.
Because NWAM is set up by default when the text installer boots, if you have chosen to
configure your system by using the Dynamic Host Control Protocol (DHCP), no further
network configuration is required to use the Device Driver Utility. However, if you are not
using DHCP, select the "Shell" option during the installation, then use the appropriate
commands to manually configure your network.

Note – The Device Driver Utility can require a minimum of 1.5 GB of memory. If your
system has devices that are adequate for performing an installation, first complete the
installation, then boot the installed hard disk before running the Device Driver Utility. This
way, the utility can take advantage of the available swap space on the installed system.

To explore Oracle Solaris on the live CD ISO image, without affecting the existing OS that is
installed on your system, refer to the following guidelines:
■ A minimum of 512 MB of memory is required to run the Oracle Solaris Live CD and the

interactive installer.
■ You can download an ISO image of the current release's live CD, then burn this image to a

CD and boot to it. Or, you can save the image on your system and then run it in a virtual
machine. See “Preparing to Run Oracle Solaris 11 Express in a Virtual Machine” on
page 24.

Exploring the Oracle Solaris Live CD
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Live CD Options
The following are the Oracle Solaris live CD options:

■ If you need to use accessibility features, you can select either the Magnifier or the Screen
Reader boot options.

Both the magnifier and screen reader boot options are displayed in the GRUB menu when
you boot the live CD. Use the arrow key to select either boot option. Then, press Return to
boot the system with the specified accessibility feature.

■ If you are prompted to log in to the live CD, both the user name and password are jack.
■ If you need to access the system as the root user, use the su command. The live CD root

password is solaris.
■ If you choose, you can install the OS on your system from the live CD ISO image. For

instructions, see “Installing From the Oracle Solaris Live CD – Quick Reference” on
page 12.

Note – Important: If you proceed to install the operating system, you will create a new user
during the installation process. After the installation, log in to the system as that user. Your
user password and the root password are initially the same. You will be prompted to create
a new, unique root password after the installation.

To finish configuring your system, use the su root command to invoke a shell that includes
privileges that are assigned to the root role or prepend privileged commands with the sudo
command.

For more detailed information, see Chapter 5, “Understanding Users and Roles.”

Installing From the Oracle Solaris Live CD – Quick
Reference
The live CD ISO image includes an installer that enables you to install Oracle Solaris on your
x86 based system.

To start the installer, select the Installer icon that is located on the live CD desktop.

When using the installer tool on the live CD, you have the following choices:

■ Install Oracle Solaris as the only operating system on your system.
■ Install Oracle Solaris on a partition that is separate from your existing OS.

Exploring the Oracle Solaris Live CD
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Caution – Be aware that the installation overwrites all of the software and data on the selected
partition.

■ Install Oracle Solaris inside a virtual machine.

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Download Oracle Solaris 11 Express. http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/

index.html

Learn more about installing and using
Oracle Solaris 11 Express.

Getting Started With Oracle Solaris 11 Express

Automate the installation of Oracle
Solaris 11 Express on multiple systems.

Oracle Solaris 11 Express Automated Installer Guide

Keep your system up to date. Oracle Solaris 11 Express Image Packaging System Guide

Manage boot environments. Managing Boot Environments With Oracle Solaris 11 Express

Related Information

Chapter 1 • Exploring Oracle Solaris 11 Express 13
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Preparing to Install Oracle Solaris 11 Express

Before installing Oracle Solaris 11 Express, review the installation options and requirements in
this chapter.

Oracle Solaris 11 Express Installation Options
There are a number of options for installing Oracle Solaris 11 Express on your system:
■ Perform a new interactive installation of the OS from the live CD ISO image or from the text

installer image.
To decide whether to use the graphical user interface (GUI) installer on the live CD or the
text installer, refer to the additional information in Chapter 3, “Installing Oracle Solaris 11
Express.” For instructions, see “How to Prepare to Install Oracle Solaris From the Live CD or
Text Installer” on page 22.

■ Run Oracle Solaris 11 Express in a virtual machine.
For instructions, see “Preparing to Run Oracle Solaris 11 Express in a Virtual Machine” on
page 24.

■ Upgrade a system that is running the OpenSolaris 2009.06 release to Oracle Solaris 11
Express. For detailed instructions, see Oracle Solaris 11 Express Release Notes .

■ Install Oracle Solaris on multiple client systems by using the automated installer (AI).
The AI essentially performs “hands-free” network installations on both x86 and SPARC
based systems. Use this option for fast installations on multiple systems that do not require
any customization.
As another option, you can download a SPARC or x86 an AI image, then burn the image to
removable media, such as a CD, DVD, or for x86 installations, a USB stick. Then, you can
boot the AI media directly on each of your systems to initiate an automated installation.
Note that each system requires network access because the installation process retrieves
packages from a networked IPS repository. Installations that use AI media are
non-interactive.
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System Requirements for Installing Oracle Solaris
The following table outlines the various requirements for installing Oracle Solaris 11 Express.

Requirement Description

Memory The minimum memory requirement is 512 MB.

Note – The live CD ISO image, and both the GUI and text installers, are capable of
functioning with a minimum of 512 MB of memory. However, this minimum
requirement varies, depending on system specifications. If your system does not have
enough memory to run the GUI installer, use the text installer instead.

Disk space The recommended size is at least 10 GB. A minimum of 4 GB is required.

x86 only: Support for
multiple operating
systems

If you are installing Oracle Solaris on an x86 based system that will have more than one
operating system installed in it, you can partition your disk during the installation
process. See “x86: Setting Up Partitions During an Interactive Installation” on page 20.

Alternatively, you can use the fdisk command or a third-party partitioning tool to
create a new partition or make adjustments to preexisting partitions prior to an
installation. See “Guidelines for Partitioning a System Prior To Installation” on
page 18.

For more information about preparing an environment for the installation of specific
operating systems, see “Preparing a Boot Environment That Supports the Installation
of Multiple Operating Systems” on page 17.

Additional Installation Considerations
When installing Oracle Solaris 11 Express, consider the following information:
■ The installer on the live CD ISO image is for 32-bit or 64-bit x86 platforms only.

If you want to install the operating system on a SPARC based system, use the text installer or
the AI tool.

■ The Oracle Solaris 11 Express installers cannot upgrade your operating system. However,
after you have installed Oracle Solaris 11 Express, you can update all of the packages on your
system that have available updates by using the Image Packaging System. See “Updating
Software Packages on Your System” on page 61.

Note – You can upgrade from the OpenSolaris 2009.06 release to Oracle Solaris 11 Express by
using a specific procedure. For instructions, see Oracle Solaris 11 Express Release Notes .

■ The interactive installers can perform an initial installation on an Oracle Solaris x86
partition, or for the text installer, on a SPARC slice. Or, the installation can use the whole
disk.

System Requirements for Installing Oracle Solaris
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Caution – The installation overwrites all of the software and data on the targeted device.

Preparing a Boot Environment That Supports the Installation
of Multiple Operating Systems

If you are installing Oracle Solaris as part of a multiple boot environment, review the
specifications for the various operating systems in the following table.

TABLE 2–1 Multiple Operating System Environments

Existing Operating System Description

Windows If you have Windows installed, and you set up sufficient disk space for
installing Oracle Solaris, the installation should be straightforward. All
versions of Oracle Solaris for the x86 platform use the GNU Grand
Unified Bootloader (GRUB). Oracle Solaris recognizes Windows and
ensures that Windows partitions remain unchanged during an
installation. When the installation completes, and the system reboots,
the GRUB menu displays both the Windows and the Oracle Solaris
boot entries.

Linux, or Windows and Linux If you have the Linux operating system, or both Linux and Windows
operating systems installed on your x86 based system, before installing
Oracle Solaris, save a copy of the menu.lst file. After the installation,
you will need to edit the menu.lst file to add the Linux information
from the previous installation. For instructions, see “How to Add a
Linux Entry to the GRUB Menu After Installing Oracle Solaris” on
page 65.

Note – When installing Oracle Solaris on a system that also has the
Linux operating system installed, the Oracle Solaris partition must
precede the Linux swap partition.

Oracle Solaris 10 OS The installer on the live CD and the text installer cannot be used to boot
multiple instances of Oracle Solaris. However, the installers can be used
to replace the Solaris 10 1/06 and later releases on an existing system
that has multiple instances of Oracle Solaris installed.

Note – If you need to preserve a specific Solaris Volume Table of
Contents (VTOC) slice in your current operating system, use the text
installer.

Preparing a Boot Environment That Supports the Installation of Multiple Operating Systems
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TABLE 2–1 Multiple Operating System Environments (Continued)
Existing Operating System Description

Extended partitions If you have another operating system on an extended partition, the
existing extended partition does not need to be changed during an
installation. You can create, resize, or delete an extended partition
when you install Oracle Solaris by using either the live CD GUI
installer, the text installer, or the automated installer. You can also
choose to install Oracle Solaris on a logical partition within an extended
partition.

For interactive installer instructions, see “Installing Oracle Solaris 11 Express by Using an
Interactive Installer” on page 29. For automated installer instructions, see the Oracle Solaris 11
Express Automated Installer Guide.

Guidelines for Partitioning a System Prior To Installation
When installing Oracle Solaris from the live CD ISO image or from the text installer image, you
can use the entire disk, or you can install the operating system on an x86 partition. With the text
installer, you can install the operating system on a SPARC slice.

On x86 based systems, the installer uses GRUB, which supports installing multiple operating
systems on one drive. You can create a partition for installing Oracle Solaris prior to
installation, as well as during an installation. After partitioning and installing the various
operating systems, you can deploy any of them by selecting the appropriate menu entry in the
GRUB menu at boot time.

▼ x86: How to Partition a System Prior to Installation
The following procedure describes how to partition an x86 based system prior to installation.
For information about partitioning a system during an installation, see “Guidelines for
Partitioning a System During an Interactive Installation” on page 19.

Back up your system.
Backing up your system is strongly recommended before partitioning your hard drive. The
Ghost for UNIX (G4U) open-source tool was designed to back up x86 based systems.

On your hard drive, create a partition for installing the operating system.
Choose one of the following options:

■ Use the fdisk command to create or modify an Oracle Solaris fdiskpartition.
For instructions, see “How to Create a Solaris fdisk Partition” in System Administration
Guide: Devices and File Systems. See also the fdisk(1M) man page.
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■ Use commercial products or open-source tools to partition your hard drive.
GParted is an open-source tool for disk partitioning. You can use this tool to create New
Technology File System (NTFS) partitions. To access the GParted tool on the live CD
desktop, double-click the GParted tool icon. To access the tool from the main menu, choose
Applications → System Tools → GParted Partition Editor.

Note – The GParted tool is not supported in the text installer media.

If you create Linux-swap partitions by using the GParted tool, note that Linux-swap uses the
same partition ID that Oracle Solaris uses. During the installation, in the disk partitioning
step, you can change the Linux-swap partition to an Oracle Solaris partition.

Use the installer to install the operating system on the Oracle Solaris fdiskpartition.

Guidelines for Partitioning a System During an Interactive
Installation

On an x86 based system, you can select, create, or modify partitions during an interactive
installation. For the text installer only, you can select, create, or modify Solaris VTOC slices
during an interactive installation.

Note – Changes you make to disk partitioning or slices are not implemented until you finish
making the installer panel selections and the installation begins. At any point prior to the
installation, you can cancel your changes and restore the original settings.

When setting up x86 partitions or extended partitions during an interactive installation, keep
the following in mind:
■ Only one Solaris partition is allowed.
■ A Solaris partition must be used for the installation.
■ If there is an existing Solaris partition, that partition is selected by default. The partition can

be a logical partition within an existing extended partition.
■ If the existing partition table cannot be read, proposed partitioning information is

displayed.

Caution – In this case, all of the existing data on the disk is destroyed during the installation.

■ During the installation, if you select the “Partition the Disk” option, the panel displays the
existing fdisk partitions for the selected disk. Up to four primary partitions are displayed in
the same order that they are laid out on the disk. Unused disk space is displayed for these
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primary partitions. The partition type, current size, and maximum available disk space for
each partition are also displayed. If an extended partition exists, its logical partitions are also
displayed in the disk layout order, within the extended partition.

x86: Setting Up Partitions During an Interactive
Installation
For installations on the x86 platform, you can make changes to disk partitioning by directly
editing the entries in the installation screens, as they are displayed. As you proceed through the
installation, the recommended and minimum sizes for installing the software are also displayed.

The following table describes the disk partitioning options that you can choose from. Use this
table to help you determine which option best suits your needs.

TABLE 2–2 Options for Partitioning a Disk During an Interactive Installation

Partitioning Option Description and User Action (if required)

Use the existing Solaris partition. This option installs Oracle Solaris 11 Express on the existing
Solaris partition using its current size. Select the Partition a Disk
option. No other changes are required.

Create a new Solaris partition. If there is currently no existing Solaris partition on the system,
you can create a new Solaris partition. To do so, select a primary
partition or a logical partition and then change its type to Solaris.
During an installation, this modification erases the existing
partition contents.

Increase the space that is allocated to a
Solaris partition and install on that
partition.

If there is enough available disk space, you can increase the size
that is allocated to a Solaris partition before installing the
software on that partition. The available space contains any
contiguous unused space before or after the selected partition. If
you enlarge the partition, unused space after the partition is used
first. Then, unused space before the partition is used, which
changes the starting cylinder of the selected partition.

Install Oracle Solaris 11 Express on a
different primary partition.

You can install the operating system on a different primary
partition. To do so, you must first change the existing Solaris
partition type to Unused. You can then select another partition
and change its type to Solaris. During an installation, this
modification erases the existing partition contents for both the
previous Solaris partition and the new Solaris partition.

Guidelines for Partitioning a System During an Interactive Installation
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TABLE 2–2 Options for Partitioning a Disk During an Interactive Installation (Continued)
Partitioning Option Description and User Action (if required)

Create a new Solaris partition within an
extended partition.

You can create a new Solaris partition within an extended
partition. If a Solaris partition already exists, change its type to
Unused. Then, to create a new extended partition, change the
partition type to Extended. You can resize the extended partition,
then change one of the logical partitions in the extended partition
to a Solaris partition. Also, you can enlarge the logical partition
up to the size of the extended partition that contains that logical
partition.

Delete an existing partition. You can delete an existing partition by changing its type to
Unused. During an installation, the partition is destroyed, and its
space is made available when resizing adjacent partitions.

Setting Up Solaris VTOC Slices With the Text Installer
For text installations on the SPARC platform, you can modify VTOC slices during the
installation. For text installations on the x86 platform, you can modify a slice within a partition,
if that partition has not already been modified during the installation.

When setting up VTOC slices, keep the following in mind:

■ The installer displays the existing slices. The slices are displayed in the order in which they
are laid out. The current size and maximum available size for each slice are also displayed.

■ Oracle Solaris must be installed in an Oracle ZFS root pool. By default, the slice that contains
the root pool is labeled rpool by the installer. If you want to install the operating system on a
slice that does not contain the root pool, change the type for that slice to rpool in the
installer. During the installation, a ZFS root pool will be created on that slice.

Note – Because there can only one ZFS pool named rpool, if there already is an rpool on the
device, the installer names any new pool using the format rpool#.

■ The size of a slice can be increased up to the maximum available size. You can change a slice
to Unused, thereby making its space available to adjacent slices.

■ If the slice is not explicitly altered, the content of the slice is preserved during the
installation.

The following table describes the options for modifying slices during a text installation.
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TABLE 2–3 Options for Modifying VTOC Slices During a Text Installation

Option Description and User Action (if required)

Use an existing slice. This option installs Oracle Solaris 11 Express on an existing VTOC slice
using its current size. Select the target slice, then change its type to rpool.

Resize a slice. You can only change the size of a newly created rpool slice. Type the new
size in the field, up to the maximum size available.

Create a new slice. Select an unused slice. For example, change its type from Unused to rpool.

Delete an existing slice. You can delete an existing slice by changing its type to Unused. During the
installation, the slice is destroyed and its space is made available when
resizing adjacent slices.

▼ How to Prepare to Install Oracle Solaris From the Live
CD or Text Installer
For x86 based systems, from the live CD, you can install the operating system either on your
system or in a virtual machine.

Alternatively, for both SPARC and x86 based systems, you can install Oracle Solaris by using a
text installer. The text installer can be used on systems that do not have graphics cards.

Note – Depending on your system configuration, the text installer may require less memory. If
the GUI installer on the live CD does not work on your system, use the text installer instead.

You can download the live CD bootable image or the text installer image at
http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.

You also have the option to download a USB image for x86 based systems.

After you download the image, do one of the following:

■ Copy the image to removable media, such as a CD, DVD, or USB stick, then continue to Steps
2 and 3.

■ For the live CD ISO image or the text installer image, you can save the image to your system
and then run it in a virtual machine. See “Running Oracle Solaris 11 Express in VirtualBox”on
page 34.

Before You Begin
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Check the requirements and limitations for running the installer on your system:

a. Verify that your system meets all of the necessary system requirements. See “System
Requirements for Installing Oracle Solaris”on page 16.

b. Review the “Additional Installation Considerations”on page 16.

c. Verify that you have all of the necessary device drivers. See “Ensuring That You Have the
Proper Device Drivers”on page 24.

Note – The Device Driver Utility can require at least 1.5 GB of memory. If your system has an
adequate complement of devices to perform an installation, first complete the installation,
then boot the installed hard disk before running the Device Driver Utility. Then, the utility
can take advantage of the swap space on the installed system.

Choose one of the following options for installing Oracle Solaris 11 Express:

■ If Oracle Solaris 11 Express is the only operating system that is to be installed on your
system, see the instructions for “Installing Oracle Solaris 11 Express by Using an Interactive
Installer”on page 29.

■ If you are setting up an environment that supports the installation of multiple operating
systems, do the following:

a. Review the specifications in “Preparing a Boot Environment That Supports the
Installation of Multiple Operating Systems”on page 17.

Caution – If you already have an Oracle Solaris fdisk partition on your system, the
installation overwrites this partition.

b. Back up your system.

When partitioning your system, this step is strongly recommended. For instructions, see
Step 1 of “Guidelines for Partitioning a System Prior To Installation” on page 18.

c. If you plan to partition your system prior to installation, see “Guidelines for Partitioning a
System Prior To Installation”on page 18.

Follow the instructions in “Installing Oracle Solaris 11 Express by Using an Interactive Installer”
on page 29.

2
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Preparing to Run Oracle Solaris 11 Express in a Virtual
Machine
The following are the various options for running Oracle Solaris in a virtual machine:

■ Run the Oracle Solaris live CD ISO image as a “guest” in the VirtualBox software. For
instructions, see “Running Oracle Solaris 11 Express in VirtualBox” on page 34.

■ Use the distribution constructor to design and build your own pre-installed Oracle Solaris
virtual machine.

■ If you are installing Oracle Solaris 11 Express on a system that is running Mac OS X, and
Parallels is also installed, see “Running Oracle Solaris on a Mac OS X System With Parallels
Installed” on page 40.

Ensuring That You Have the Proper Device Drivers
Before installing Oracle Solaris, determine whether your system's devices are supported. The
Hardware Compatibility List (HCL) at http://www.sun.com/bigadmin/hcl/data/os/
provides information about hardware that is certified or reported to work with Oracle Solaris.
The Solaris on x86 Platforms Device Support tool tells you which Oracle Solaris driver supports
the various x86 components.

The following utilities can also be used to determine whether a device driver is available:

■ Device Driver Utility
The Device Driver Utility provides the same information as the Oracle Device Detection
Tool. This utility is available on the Oracle Solaris 11 Express Live CD ISO image and also
on the desktop of an installed system. The utility is also available through the text installer
menu options.

■ Oracle Device Detection Tool
The Oracle Device Detection Tool reports whether the current release supports the devices
that have been detected on your system. This tool runs on many different systems, including
several different Oracle Solaris 10 releases, Windows, Linux, Mac OS X, and FreeBSD. There
is a link to the Oracle Device Detection Tool on the HCL (http://www.sun.com/bigadmin/
hcl/data/os/). For instructions on using the tool, see “How to Use the Oracle Device
Detection Tool” on page 28.

▼ How to Use the Device Driver Utility
The Device Driver Utility provides information about the devices on your system and the
drivers that manage those devices. The utility reports whether the currently booted operating
system has drivers for all of the devices that are detected in your system. If a device does not
have a driver attached, the Device Driver Utility recommends a driver package to install.

Ensuring That You Have the Proper Device Drivers
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The Device Driver Utility runs automatically when you boot an installation image. You can also
manually start the Device Driver Utility after you have installed Oracle Solaris.

You can also use the Device Driver Utility to submit your system information to the HCL at
http://www.sun.com/bigadmin/hcl/data/os/. Your system and its components are then
listed on the HCL as “Reported to Work”.

Start the Device Driver Utility by using one of the following methods:

■ Boot the live CD installation image.

When you boot the live CD ISO image, the Device Driver Utility runs in the background. If
a missing driver is found in an IPS package from the default publisher, the Device Driver
Utility installs that driver package automatically. If any other drivers are missing, the Device
Driver Utility displays a dialog that prompts you display the utility window, so that you can
review the report and install any additional missing drivers.

■ Manually start the Device Driver Utility from the desktop of the live CD.

To manually start the Device Driver Utility from the desktop of the live CD, double-click the
Device Driver Utility icon on the desktop. Or, choose Applications → System Tools →
Device Driver Utility from the main menu.

■ Boot the Oracle Solaris text installer image.

To start the Device Driver Utility from the text installer, choose Install Additional Drivers
from the initial menu.

Note – The NWAM feature of Oracle Solaris is set up by default when the text installer boots.
If you are using DHCP, no further network setup is necessary to use the Device Driver
Utility. If you are not using DHCP, select the Shell option on the initial menu, then use the
appropriate commands to manually configure your network settings before using the
Device Driver Utility.

■ Start the Device Driver Utility on an installed system.

To start the Device Driver Utility from the desktop of an installed system, choose
Applications → System Tools → Device Driver Utility from the main menu.

The Device Driver Utility scans your system and then displays a list of the devices that are
detected. For each device that is detected, the list displays information, such as manufacturer,
model, and the name of the driver that is currently managing the device. If the utility detects a
device that does not have a driver attached, that device is selected on the device list. From here,
you can display more information about the device and install the missing driver.
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To display more details about a particular device:

a. Right-click the device, then select Show Details from the popup menu.

The Device and Driver Details window is displayed. The device name, vendor name, node
name, driver name, and other detailed information about the device is displayed in this
window.

b. To display more details about a missing driver, click the Info link for the selected device.

If no driver is currently managing the device, the Driver column of the device list displays a
status for the driver of that device.

■ If there is a missing driver in one of your configured IPS package repositories, the driver
status for that device entry is IPS.

■ If there is a missing driver in a System V Revision 4 package (SVR4), the driver status for
that device entry is SVR4.

■ If there is a missing driver in a DU package, the driver status for that device entry is DU.
■ If the Device Driver Utility cannot locate an Oracle Solaris driver for this device, the

driver status is UNK.

Install the missing drivers, as follows:

■ To install an IPS driver, do the following:

a. Click the Info link in the corresponding row of the table to get information about the IPS
package that contains the driver for the device.

When you click the Info link, the text field for the Package radio button is populated with
the relevant package information. The correct publisher is selected from the drop-down
menu.

b. Click the Install button to install the package.

■ If the Info link lists an IPS package from a publisher that is not configured, follow
these steps:

i. Select Add Repository from the repositories drop-down menu.

The Repositories manager window is displayed.

ii. Add the name and URI of the new repository, then click Add.

■ If the Package field is not populated, type the name of the IPS package from the Info
link, then click Install.
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■ To install SVR4 or DU drivers, do the following:

■ If a URL for the package is provided, type the URL in the File/URL field, then click Install.

■ If you have a copy of the package on your system, use the Browse button to select the
package, then click Install.

■ If the driver status is displayed as UNK, do the following:

a. Click the name of the device that you want this driver to manage.

b. Type the relevant package information in either the Package field or the File/URL field,
then click Install.

c. (Optional) To share information about a driver that works for the device, click the Submit
button.

(Optional) To list your system and its components as“Reported to work”on the HCL click the
Submit button.

The Submit Information To Hardware Compatibility List window opens. This window displays
all of the information that was collected about your system.

a. From the drop-down list, select the System Type.

b. Type the appropriate information in any of the fields that were not automatically populated.

■ The Manufacturer Name is the name of the system maker, for example, Toshiba,
Hewlett-Packard, or Dell.

■ Provide the complete model number.

The BIOS/Firmware Maker is the information on the BIOS Setup screen that is usually
displayed while the system is booting.

■ The CPU Type is the name of the CPU maker.

c. Provide your name and Email address.

d. In the General Notes field, add any additional comments, then click Submit.

■ If you do not have Internet access, click the Save button, and submit the report later.

For more information about using the Device Driver Utility, click the Help button.
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▼ How to Use the Oracle Device Detection Tool
As an alternative to the Device Driver Utility, you can use the Oracle Device Detection Tool to
determine whether the current release includes drivers for all of the devices on your system.

Review the information in the “System Requirements for Installing Oracle Solaris” on page 16
section.

Open a web browser and go to http://www.sun.com/bigadmin/hcl/hcts/

device_detect.jsp.

In the Using the Device Detection Tool section, click the Start Oracle Device Detection Tool
option.

Accept the license agreement.

Click the ddtool download link.

Select the Open with JavaWS option, then select Run.
The tool runs, but it is not installed on your system.

Select the Target Operating System for which you want to check driver availability.
For additional information, click the Help button.

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find out more about performing an installation
on multiple systems by using AI media.

Oracle Solaris 11 Express Automated Installer Guide

Find out more about using the Oracle Device
Detection Tool.

http://www.sun.com/

bigadmin/hcl/hcts/device_detect.jsp

Find out more about using the Device Driver
Utility.

See the Device Driver Utility online help.

Find system administration tasks for managing
disks and devices.

System Administration Guide: Devices and File Systems

Before You Begin
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Installing Oracle Solaris 11 Express

When installing Oracle Solaris 11 Express, you can choose from the following installation
options:

■ “Installing Oracle Solaris 11 Express by Using an Interactive Installer” on page 29
■ “Running Oracle Solaris 11 Express in VirtualBox” on page 34
■ “Running Oracle Solaris on a Mac OS X System With Parallels Installed” on page 40

Installing Oracle Solaris 11 Express by Using an Interactive
Installer

You can install Oracle Solaris by using either the GUI installer on the live CD or the text
installer option. Both installers can be used to install Oracle Solaris on the x86 platform. The
text installer can also be used to install Oracle Solaris on the SPARC platform. Both installers are
capable of functioning with a minimum of 512 MB of memory. Both installers enable you to
select, create, or modify partitions during an installation.

The text installer has the following advantages over the GUI installer:

■ Enables you to install the operating system on either SPARC or x86 based systems. The text
installer enables you to select, create, or modify VTOC slices or partitions for use in the
installation.

■ Can be used on systems that do not have (or do require) graphics cards.
■ Can require less memory than the GUI installer, depending on your system's specifications.
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Note – If you use the text installer, be aware that it does not install all of the software packages
that are included when installing from the live CD. In particular, the text installer does not
install the GNOME desktop. You work from the command line on the installed system. To
install additional packages after an installation with the text installer, see Appendix B,
“Troubleshooting the Oracle Solaris 11 Express Release.”

To download either the live CD ISO image or the text installer image, go to
http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.

Interactive Installation Settings and Guidelines
Following are the default network and security settings that are used by the GUI installer on the
live CD and by the text installer:
■ Oracle Solaris is automatically networked by using DHCP, with Domain Name System

(DNS) resolution.
The DNS domain and server Internet Protocol (IP) addresses are retrieved from the DHCP
server.

■ IPv6 is disabled.
■ The NFSv4 domain is dynamically derived.
■ The nwamd daemon, which is controlled by the Service Management Facility (SMF),

performs automatic network configuration.
■ Kerberos is disabled.

When installing Oracle Solaris, note the following important information about disk
partitioning:
■ The installation overwrites the whole disk layout, if any of the following is true:

■ The disk table cannot be read.
■ The disk was not previously partitioned.
■ You select the entire disk for the installation.

■ A maximum of 2 TB on a disk or a partition can be used for installing the OS, regardless of
whether the disk or partition is larger than 2 TB. Disks that do not have enough space for a
successful installation are labeled as such.

■ If an existing Oracle Solaris fdisk partition is on a system, and you make no modifications
to the existing partitions, the installation overwrites the Oracle Solaris fdisk partition only.
Other existing partitions are not changed.

For more information about partitioning a system before an installation, see “Guidelines for
Partitioning a System Prior To Installation” on page 18.
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For information about partitioning a system during an interactive installation, see “Guidelines
for Partitioning a System During an Interactive Installation” on page 19.

Performing an Interactive Installation
Whether you are using the GUI installer on the live CD or the text installer, you follow the same
basic steps to perform an installation. However, the order in which the steps are performed and
the details that are displayed on each installation panel might vary, depending on which
installer you are using, and whether you are installing on the SPARC or x86 platform.

Review the following basic installation steps. For detailed instructions on what to do at a
particular installer screen, see the online help for that screen.

TABLE 3–1 Interactive Installation Steps

Step Instructions

1. Complete any
preliminary tasks.

Review the guidelines in Chapter 2, “Preparing to Install Oracle Solaris 11 Express.” In
particular, if you are planning to set up and install Oracle Solaris on a partition or slice
and have not done so yet, review the information in “x86: Setting Up Partitions
During an Interactive Installation” on page 20.

You can download either the live CD ISO image or the text installer image, then copy
the image to removable media, such as a CD, DVD, or a USB stick. Alternatively, you
can run the image inside VirtualBox.

To download the Oracle Solaris Live CD ISO image or the text installer image, go to
http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.

Note – If you have previously installed the Linux operating system, you will need to
save a copy of the existing menu.lst file to a USB drive for use after the installation.
For instructions, see “Adding a Linux OS Entry From a Previous Installation to the
GRUB Menu” on page 65.

2. Insert the
installation media,
boot the system, then
make any preliminary
language selections.

On the live CD, when the GRUB menu is displayed, select the Boot From CD option.
■ If you are prompted to log in to the live CD, the user name and password are jack.

■ The root password is solaris.

3. (Conditional) Install
any missing drivers
that are required for
installation.

When you boot the live CD, if any drivers are missing, a prompt is displayed. Follow
the instructions for accessing the Device Driver Utility to locate and install any drivers
that are required for the installation.

Alternatively, you can select option #2 on the initial text installer menu to install
required drivers before selecting option #1 to install Oracle Solaris.

For instructions on using the Device Driver Utility, see “How to Use the Device
Driver Utility” on page 24.
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TABLE 3–1 Interactive Installation Steps (Continued)
Step Instructions

4. Initiate the
installation.

■ On the live CD desktop, double-click the Install Oracle Solaris icon to start the
GUI installer.

■ On the text installer initial menu, select option #1 to initiate an installation of
Oracle Solaris.

5. Select an installation
target. Optionally, you
can modify the
partition or slice
layout.

In the series of Disks panels that is displayed, choose whether to install the operating
system on the whole disk or on a partition or a slice on the disk. You can modify the
partition or slice layout. For instructions, see “x86: Setting Up Partitions During an
Interactive Installation” on page 20 and “Setting Up Solaris VTOC Slices With the
Text Installer” on page 21. At any point during this phase of the installation, you can
revert to the original settings.

Caution – If the existing partition table cannot be read, the panel displays proposed
partitioning. In this instance, all of the data on the disk is destroyed during the
installation.

6. Complete date,
time, and time zone
settings.

Select the default date and time, then select a time zone or location. The installer uses
the time zone from the system's internal settings as the default, if possible.

7. Select the language
and locale.

The language and locale selections determine the language support and other data
formats for the installed system. Note that for the text installer, language support is
selected when the system boots, prior to running the installer.

You can change either the default locale or the locale for that particular section any
time that you log in to the system. To change the locale during login, click the Options
button, then choose Select language.
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TABLE 3–1 Interactive Installation Steps (Continued)
Step Instructions

8. Complete the user
settings.

To complete the user account setup, a login name and password are required.
■ Type a user name and password.

■ The login name must begin with a letter and can only contain letters and
numbers.

■ For the text installer, provide a root password.
If you do not create a user account during the installation, the root account is
set up as a regular user account rather than a role.

■ For the GUI installer, you are not required to provide a root password during
the installation.
On an installed system, the initial root password defaults to the user account
password that you entered during the installation.

Note – The first time you use the root password, you are prompted to change
the password.

■ Type a computer name or accept the default. This field cannot be blank.
For the GUI installer, the computer name field is included in the user panel. For
the text installer, this field is located in the network configuration panel.

9. Text installer only:
Specify the network
configuration
information.

Specify how the network should be configured, as follows:
■ Allow DHCP to configure the connection automatically.

■ Skip the network configuration step during the installation, then configure the
network settings after the installation.

10. Review the
installation
specifications.

Review the specifications in the Installation Summary screen. If necessary, go back
and make any required changes before starting the installation.

11. Install the system
using the
specifications you have
provided.

The Oracle Solaris installation process begins.

Caution – Do not interrupt an installation that is in progress. An incomplete
installation can leave a disk in an indeterminate state.

12. Review the
installation logs.

The Installation Results panel provides access to installation logs that you can review.

13. Reboot the system,
or quit the installer
and shut down the
system.

After a successful installation, reboot the system or exit the installer and shut down
the system.

Eject the live CD as the next system boot begins. Or, select the “Boot from Hard Disk”
option in the GRUB menu.

If the installation fails, you can view the installation log and exit the installer.

14. (optional) Perform
any additional steps.

For further instructions, see “Related Information” on page 41.
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Running Oracle Solaris 11 Express in VirtualBox
The following information pertains to running the live CD ISO image inside the VirtualBox
software. You also have the option of running a text installer image inside VirtualBox.

VirtualBox is an application that runs on your operating system to provide a virtual
environment, also called a virtual machine, that enables you to install other operating systems as
“guests” inside the virtual machine.

Oracle Solaris provides improved host operating system support for VirtualBox. Depending on
the configuration, the operating system can proxy USB devices that are plugged into the host
operating system to the guest operating system.

Note – Oracle Solaris can be installed and run in other virtual applications, for example,
VMware.

The following table describes the host operating systems that VirtualBox supports.

TABLE 3–2 VirtualBox Hosts

Host Operating Systems Supported Versions

Oracle Solaris All versions

Windows ■ Windows XP – All service packs
■ Windows Server 2003
■ Windows Vista (32-bit and 64-bit)

Linux on 32-bit and 64-bit systems ■ Debian GNU/Linux 3.1 (at minimum)
■ Fedora Core 4 (at minimum)
■ Gentoo Linux
■ Mandriva 2007.1 and 2008.0
■ OpenSuSE 10.1 (at minimum)
■ Red Hat Enterprise Linux 3 (at minimum)
■ SuSE Linux 9 (at minimum)
■ Ubuntu 5.10 (at minimum)

Mac OS X (Intel) All versions
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▼ How to Download and Install VirtualBox for Use With
Oracle Solaris
If you want to run Oracle Solaris inside VirtualBox, you must first install the VirtualBox
software on your system. After VirtualBox is successfully installed, you can run the live CD ISO
image as a virtual guest. Or, you can install Oracle Solaris inside VirtualBox, and then run the
installed system as a virtual guest.

Note – A minimum of 10 GB of disk space is recommended to install the VirtualBox software
and Oracle Solaris inside VirtualBox.

Download the VirtualBox software that is appropriate for your operating system.

Save the application to your desktop or to a local disk.

Download the live CD ISO image.

To download the image, go to http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html. Note that the download
can take several minutes to complete.

For convenience, save the file to the same location that you stored your VirtualBox files.

Note – The live CD ISO image requires approximately 685 MB of disk space on your hard drive.

Following the instructions that are specific to your“host”operating system, install the
appropriate version of VirtualBox.

■ For instructions on installing VirtualBox on a Windows or Mac OS X (Intel) system, see
“How to Install VirtualBox on Windows or a Mac OS X (Intel) System” on page 36.

■ For instructions on installing VirtualBox on a Linux system, see “How to Install VirtualBox
on a Linux System” on page 36.

Configure VirtualBox, per the instructions in “How to Configure VirtualBox For Use With the
Oracle Solaris Software”on page 37.

Start Oracle Solaris, per the instructions in “How to Start Oracle Solaris 11 Express by Using
VirtualBox”on page 39.
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▼ How to Install VirtualBox on Windows or a Mac OS X
(Intel) System

Navigate to the downloaded VirtualBox installation files or folder.
For Mac OS X, this is a .dmg image file.

To start the installation, double-click the VirtualBox installation file, then lick Next or Continue.

Accept the license agreement, then click Next or Continue.

Choose a location to install the VirtualBox software.
The available choices are Accept the Default Location and Modify the Location.

Note – To install both VirtualBox and the Oracle Solaris live CD ISO image, a minimum of 10
GB of disk space is required.

Click Install.
If prompted, type your user password.

When the installation completes, click Close or Finish.

▼ How to Install VirtualBox on a Linux System
Even if your Linux distribution comes with a version of VirtualBox pre-installed, download the
latest version of VirtualBox. The pre-installed VirtualBox software is usually the Open Source
Edition (OSE), which might not be suitable for running with Oracle Solaris 11 Express. For
instructions, see “How to Download and Install VirtualBox for Use With Oracle Solaris” on
page 35.

Open a terminal window and assume the root role or become the rootuser.
$ su root

Password:

Navigate to the downloaded VirtualBox installation file.

Depending on your Linux distribution, start the installation process by typing one of the
following commands:

■ On rpm-based systems, such as Fedora, SuSE, or Red Hat, type the following command:
# rpm -ihv filename
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■ On deb-based systems, like Debian, or Ubuntu, type the following command:
# dpkg -i filename

In the previous commands, filename is the name of the downloaded installation file.

Note that you might need to install additional packages to fulfill certain dependencies.

The installer searches for a precompiled kernel module. If no precompiled kernel module is
available for your system, the installer attempts to compile and install a kernel module.

Note – For the installer to build the kernel module, you need to have basic build utilities, such as
gcc, make, binutils, and kernel header, installed. Typically, these utilities are part of the
standard installation of your Linux system. If the utilities are not readily available, the installer is
not able to build the kernel module. In this case, you will need to install the build utilities and
then manually start the kernel module compilation by running the /etc/init.d vboxdrv
setup command as the root user.

Add the current user to the vboxusersgroup.

a. In a terminal window, type:
# usermod -G vboxusers -a username

where username is the name of the current user.

b. To apply the changes, log out and then log back in to the system.

To start VirtualBox, open a terminal window and type VirtualBox, then press Enter.

Accept the license agreement to continue.

▼ How to Configure VirtualBox For Use With the Oracle
Solaris Software
If you have an Oracle Solaris Live CD ISO image, boot your host operating system, then insert
the live CD. To download the live CD ISO image, go to http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.

Start VirtualBox by using one of the following methods:

■ On Windows, click the Start button, then select VirtualBox from the list of programs.

■ On Linux, open a terminal window, type VirtualBox, then press Enter.

■ On Mac OS X, open Applications in the Finder, then double-click VirtualBox.
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On the first start of VirtualBox, type your registration information, then click Confirm.

The main VirtualBox window is displayed.

Click the New icon on the left side of the VirtualBox window.

In the popup menu, click Next.

Type a name for your virtual machine.

From the drop-down list, select Oracle Solaris as the operating system, then click Next.

Select the amount of Random Access Memory (RAM) to allocate to the Oracle Solaris installation
inside VirtualBox, then click Next.

Note – If you have 2 GB or more of memory on your system, select 1 GB for optimal
performance. The recommended minimum size is 512 MB.

Add a Virtual Disk Image (vdi) by selecting a name or by adding a new name to the list.

For the initial installation:

a. Select New, then click Next.

b. Accept the default Dynamically Expanding Image, then click Next.

c. Accept the default name or type a path and name, then allocate space for the image.

d. When you have completed the settings, click Next.

e. Click Finish to create the disk image.

When the initial Virtual Disk Manager GUI is displayed, with your new vdifile selected, click
Next.

In the Summary screen, click Finish.

The main VirtualBox window opens. Your virtual Oracle Solaris machine is displayed in the left
panel and is ready to use as a virtual machine.

In the Details tab, click the CD/DVD-ROM link.
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Check Mount CD/DVD Drive, then do one of the following:

■ If you are using the live CD ISO image, select Host CD/DVD Drive, then close the Settings
screen.

You are done.

■ If you are using a downloaded Oracle Solaris Live CD ISO image, select the ISO Image File,
then proceed to the next step.

From the drop-down list, select the downloaded Oracle Solaris ISO image.

■ If the live CD ISO image is not displayed in the list, add the image, as follows:

a. Click the Select icon from the drop-down list.

b. Click the CD/DVD Images tab.

c. Click the Add icon.

d. Navigate to the downloaded Oracle Solaris ISO image file, then click Open.

e. Click Select, then close the Settings screen.

▼ How to Start Oracle Solaris 11 Express by Using
VirtualBox

Start VirtualBox by using one of the following methods:

■ If you are running Windows, click the Start button. Then, from the list of programs, select
VirtualBox.

■ If you are running Linux, select VirtualBox from the System Tools menu on the GNOME
desktop or the System menu on the KDE desktop.

■ If you are running Mac OS X, open Applications in the Finder and double-click VirtualBox.

Double-click your virtual machine icon, or click the icon once, then click Start.

If you do not have the ISO image on a CD, click the CD/DVD-ROM link, then verify that the Oracle
Solaris Live CD ISO image file is selected.
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When the list of keyboard layouts is displayed, press Enter to accept the English default.

■ Alternatively, you can type the number for your particular keyboard layout, then press Enter.

Note – If your cursor becomes entrapped within the virtual desktop, you can release it by using
the host key. This key is located in the lower right corner of the VirtualBox window. On a
Windows or Linux system, the host key is the right Ctrl key. On a Mac OS X system, the host key
is the left Cmd key.

When the list of desktop languages is displayed, press Enter to accept the English default.

■ Alternatively, you can type the number of another language, then press Enter.

The application takes approximately one to two minutes to load.

When the desktop screen is displayed, you are “in the box”, running Oracle Solaris.

To install Oracle Solaris on your virtual hard disk, click the Install Oracle Solaris icon that is
located on the desktop.
Installing Oracle Solaris saves the configuration and enables you to install other programs in
VirtualBox.

For installation instructions, see “Installing Oracle Solaris 11 Express by Using an Interactive
Installer” on page 29.

Running Oracle Solaris on a Mac OS X System With Parallels
Installed

The following procedure describes how to install Oracle Solaris on a system that is running Mac
OS X, with Parallels installed.

▼ How to Install Oracle Solaris 11 Express on a System
Using Parallels
See the “Solaris Network Driver Installation” instructions in the Parallels Desktop for Mac User
Guide at http://www.parallels.com/files/upload/
Parallels_Desktop_for_Mac_User_Guide.pdf.

During the Parallels pseudo environment setup, set the networking choice to Ethernet bridge.

Using Parallels, boot the live CD ISO image.
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Continue the installation.

After installing the operating system, install the network driver.

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find out more about how user accounts and
roles are set up and managed.

Chapter 5, “Understanding Users and Roles”

Troubleshoot login and user account issues. “Troubleshooting Login and User Account Issues” on
page 72

Manually add a Linux OS entry from a previous
installation to the GRUB menu after an
installation.

“How to Add a Linux Entry to the GRUB Menu After
Installing Oracle Solaris” on page 65.

Find system administration tasks for
configuring your network.

System Administration Guide: Network Interfaces and
Network Virtualization
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Verifying and Finalizing Your Installed System

This chapter includes the following information to assist you in completing the setup of your
installed system.

■ “Managing Your Automatic Network Connection” on page 43
■ “Getting Additional Software” on page 44
■ “Managing Your Printing Environment” on page 46

Managing Your Automatic Network Connection
The Network Auto-Magic (NWAM) feature of Oracle Solaris simplifies network configuration
by addressing basic and moderate Ethernet and WiFi configurations, such as connecting to
your wired or wireless network at startup and displaying notifications about the status of your
network connection in the desktop. By default, NWAM is enabled on your system during the
installation process. NWAM uses DHCP to obtain both an IP address and DNS name service
configuration parameters. Static IP addresses and manual name service settings are also
supported. NWAM uses different network configurations that are stored and activated, either
manually or automatically, in response to changes in your network environment.

The nwamd daemon is the policy component of NWAM. This daemon functions in multiple
roles to manage your system's network configuration. The nwamd daemon is managed by the
Service Management Facility (SMF). For more information, see the nwamd(1M) man page.

Checking the Status of Your Network Connection
The quickest way to obtain essential information about your network is to check the Network
Status panel icon that is displayed in the panel notification area of the GNOME desktop. The
Network Status panel icon is the primary method for viewing information about your currently
active network connection and for interacting with NWAM. Another way to display
information about your currently active network connection is to hover your mouse over the
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panel icon. To obtain more detailed information about your wireless network (if any), or to
change the currently active network interface, right-click the Network Status panel icon to
access additional menu options.

The Network Status panel icon's appearance changes, depending on the status of your enabled
wired and wireless network interfaces. For example, the following figure shows how the icon
appears if all enabled interfaces are wireless and connected, or active.

Whereas, the following figure shows how the icon appears if at least one enabled interface is
wired and disconnected, or inactive.

Getting Additional Software
After installing Oracle Solaris 11 Express, you may find that some of the software applications
that you use on a regular basis are not immediately available to you. You can install these
software applications from a package repository, by using either the Package Manager GUI or
the IPS command-line interface (CLI).

IPS is a framework that provides the capability for software lifecycle management, which
includes installation, upgrade, and the removal of packages. IPS also provides you with the
ability to upgrade all of those packages on your installed system that have available updates.

With IPS, you can do the following:

■ Search for packages that are already installed on your system or packages that are available
from a specified package repository.

■ Add package sources (publishers) that can be searched.
■ Get information about installing packages, such as package dependencies and any

additional packages to be installed.
■ Download and install packages with a single click.
■ Update existing packages on a system.
■ Remove (uninstall) existing packages.

Note that your system must be connected to the Internet to use the default package repository.

For more information, see the pkg(1) man page.

Getting Additional Software

Getting Started With Oracle Solaris 11 Express • November 201044



▼ How to Install Software Packages by Using Package
Manager
Package Manager is the GUI for IPS. Package Manager provides a subset of the functionality
that is offered by using IPS commands. With Package Manager, you can search for and manage
publishers, and administer boot environments. The following procedure provides basic
instructions on how to use Package Manager to add software packages to your system. For more
detailed instructions, refer to the Package Manager online help.

Start Package Manager in one of the following ways:

■ Click the Package Manger icon in the GNOME desktop tool panel.
■ Double-click the Package Manger icon that is located on the desktop.
■ From the main menu of the desktop, choose System → Administration → Package

Manager.

If prompted, type the rootpassword.
The Package Manager window opens and catalogs of the publishers that you have defined are
loaded.

In the View drop-down menu, make sure the All Packages option is selected.

In the Publisher drop-down menu, select the publisher to search, or select the All Publishers
(Search Ctrl-F) option.
Your newly installed Oracle Solaris system has one publisher (package source) configured, the
solaris publisher. The repository for the solaris publisher is http://pkg.oracle.com/
solaris/release. You can search for packages on this web site, as well as by using Package
Manager or the pkg command.

In the Search field, type a word from the name or description of the package that you want to
install or update, then press Return (or Enter).
For example, to search for the OpenOffice package, type “office” in the Search field.

■ Or, click the icon of the magnifying glass to the right of the Search field to search for
packages with that name.

The Status column indicates whether the package is installed. The Status column also indicates
whether there is an update currently available for an installed package.

Tip – Hovering your mouse over the icon also displays the current status of the package.

To select the package, click the check box next to the package name.
Note that you can select multiple packages at one time by selecting multiple check boxes.
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(Optional) To get more information about a package, click the package entry in the list to select
the package.

■ To learn about dependencies for the currently selected package click the Dependencies tab
in the Details panel.

The Details panel displays additional information about the package that is currently selected
with your cursor. Although you can select multiple packages at one time (by selecting multiple
check boxes), you can only view details about the one package that is currently selected.

Click the Install/Update icon on the Package Manager toolbar to install the package (or
packages).

Package Manager checks for and evaluates whether there are any package dependencies. The
Install/Update Confirmation dialog displays the name, publisher, and summary about the
package that is displayed in the package list.

Click Proceed to install the package or update the listed packages, or click Cancel to cancel the
installation.

■ If a license dialog box is displayed, accept the license agreement to install the package.

Package Manager downloads and installs (or updates) the packages that are listed in the
Confirmation dialog box. The Install/Update window displays a log of the installation.

When the installation has successfully completed, the Status column in the Package Manager
package list displays the Installed icon (a plain box).

(Optional) To update all of the packages that have available updates, click the Updates button.

Managing Your Printing Environment
The Common UNIX Printing System (CUPS) is the default print service in Oracle Solaris 11
Express, replacing the LP print service. CUPS is a modular printing system that enables your
system to function as both a print server and a print client. A system that is running CUPS
becomes a host that can accept print requests from client systems, process those requests, then
send them to the appropriate printer.

CUPS has both a web browser interface and a GUI. Each of these tools can be used to manage
your printing environment. To access the web browser interface, type http://localhost:631
in the location bar of your browser. To start CUPS Print Manager from the desktop, choose
System → Administration → Print Manager.
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Configuring Your System as a Local CUPS Server
Your local system can be configured as a CUPS server. To configure your system as a local
CUPS server, you must specify certain server settings.

To begin, start CUPS Print Manager GUI by choosing System → Administration → Print
Manager. Then, choose Server → Settings to display the Basic Server Settings dialog.

In the Basic Server Settings dialog select the following settings:

Show printers that are shared by other systems
Enables other CUPS print queues to be visible to your local system.

Publish shared printers connected to this system
Publishes a list of print queues that are configured on your system to other systems on a local
area network (LAN).

Allow printing from the Internet
Enables published print queues to be accessible beyond the LAN.

Allow remote printer administration
Enables remote administration of the print queue.

Allow users to cancel any jobs (not just their own)
Enables users to cancel any print jobs.

Save debugging information
Enables the logging of debugging information for troubleshooting purposes.

▼ How to Set Up a New Local Printer by Using CUPS
Connect the new printer to your system, then power it on.
The newly attached printer is detected by the system, and the Printer configuration dialog
opens, displaying information about the new printer.

To finish configuring the new printer, skip to Step 2.

■ If you are adding a new printer that was not automatically detected, do the following:

a. Start CUPS Print Manager from the desktop by choosing System → Administration →
Print Manager.

■ To start the CUPS Print Manager GUI from a terminal window, type the following
command:
$ system-config-printer &
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b. In the Printer configuration dialog, choose Server → New → Printer from the main menu.
Alternatively, you can click the New icon that is located on the menubar.

c. When prompted, type the rootpassword.
The Printer configuration dialog opens, displaying all of the configured printers and the
new printer.

In the Select Device window, select the appropriate device, then click Forward.
By default, CUPS selects the USB device that is physically connected to your system or the
device that was detected by the Hardware Abstraction Layer (HAL). Note that these two entries
might be for the same printer.

In the Choose Driver window, select a Make for your printer, then click Forward.

In the next screen, do one of the following:

■ Use the default, Select Printer From Database, option.
If this option is used, the appropriate printer make is selected for you.

■ Provide your own PPD file by following these steps:

a. Select the Provide PPD File option.
The Select a File window opens.

b. Locate the specified PPD file on your system, then click Open to associate the PPD file
with the new printer.

Note – This procedure does not describe how to download and copy a PPD file to your
system.

From the left pane of the next Choose Driver window, select a printer Model.

From the right pane, select a printer driver, then click Forward.
By default, CUPS selects a “recommended” printer model and driver for your printer. However,
you can optionally make another selection from the list of available drivers.

In the Installable Options window, set or change any of the available options, then click
Forward.

In the Describe Printer window, provide the following information about the printer:

■ Printer Name
■ Description
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■ Location

(Optional) To go back and make changes to a previous screen, click the Back button.

To save your changes, click Apply, and if prompted, type the rootpassword.
After you have saved the changes, the newly configured printer is displayed in the CUPS Print
Manager window.

To set the printer as the default, right-click the printer, then do the following:

a. Select the Set as Default option.

b. In the Set Default Printer window, choose one of the following options:

■ Set as the system-wide default printer (default)
■ Set as my personal default printer

Save the printer configuration.

Print a test page to verify that the printer is configured correctly and working.

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find about more about NWAM. Chapter 1, “Introduction to NWAM,” in System
Administration Guide: Network Interfaces and Network
Virtualization

Find out more about IPS. Oracle Solaris 11 Express Image Packaging System Guide

Find out more about the Device Driver
Utility.

See the Device Driver Utility online help.

Find system administration tasks for setting
up and administering printers by using
CUPS.

Chapter 3, “Setting Up and Administering Printers by Using
CUPS (Tasks),” in System Administration Guide: Printing
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Understanding Users and Roles

This chapter provides a general overview that describes the function of users, roles, and rights
profiles in the Oracle Solaris operating system.

User Accounts, Roles, and Rights Profiles
The assignment of user accounts, roles, and rights profiles in Oracle Solaris conforms to
Role-Based Access Control (RBAC) specifications. RBAC provides a more secure alternative to
the all-or-nothing superuser model.

RBAC implements the security principle of least privilege. Least privilege means that a user has
only those capabilities that are necessary to perform a specific job. Capabilities that are beyond
regular user capabilities are grouped together into rights profiles. These profiles are assigned to
special user accounts, called roles. A user assumes a role to perform a job that requires some of
superuser's capabilities.

In the default Oracle Solaris system configuration, the user account that is created during
installation is assigned the root role if you used the text installation method. If you did not
create a user account during the installation, root is set up as an account. See “How User
Accounts Are Set Up” on page 52.

To better understand the purpose and function of user accounts, roles, and rights profiles,
review the following information:
■ A user account is a login account. Regular users can log in and use the system, but cannot

administer the system.
■ A role is not a login account. For example, you cannot directly log in to the root role.

Instead, you log in as your user name, then use the su - root command to assume the root
role. A user can only assume roles that are assigned to the user's login account.

■ A rights profile is a collection of administrative capabilities that is typically assigned to a
role, but can be assigned to a user. The names of rights profiles indicate the capabilities of
the profiles, such as System Administrator or Printer Management. Typically, the system
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administrator creates a role with the same name as the rights profile and assigns the profile
to that role. Also, rights profiles are hierarchical, that is, one rights profile can include other
rights profiles. When a role is assigned a rights profile that includes other profiles, that role
has the capabilities of all of those profiles.

Oracle Solaris provides predefined rights profiles. These profiles, listed in the
/etc/security/prof_attr, can be assigned by the root role to any account. The root role is
assigned all privileges and all authorizations, so can perform all tasks, just as root can when
root is a user.

To perform administrative functions, you open a terminal and switch the user to root. In that
terminal, you can then perform all administrative functions.

$ su - root

Password: Type root password
#

When you exit the shell, root capabilities are no longer in effect.

How User Accounts Are Set Up
During the Oracle Solaris installation process, you are prompted to create a user account and
password for your system.

For a GUI installation from the live CD ISO image, the user account and password information
are fields that must be completed during an installation. The user password is also the initial
root password for your system.

Note – During a text installation, you are prompted to create a user account and password, as
well as a root password for the system. For this installation method, the root user is a role that
you assume. However, if you do not create a user account during the installation, root is set up
as an account rather than a role.

If you used the text installer to install Oracle Solaris, the user account and root specifications
that are outlined in this chapter do not all apply.

Review the following login, user account, and root specifications:
■ The root role cannot log in. You must log in as the user you created during the installation.

After you log in, you can assume the root role to configure the system. To assume the role,
open a terminal window and use the su - root command.
If you try to log in to the installed system as root, an error message is displayed. Click OK
and then log in as the user you created during the installation.

■ After you install Oracle Solaris, you can change the installed system to permit root to log in.
However, you must first remove root as an assigned role.

How User Accounts Are Set Up
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# usermod -R your-login

The preceding command removes all assigned roles from your login account.
■ You can change the root role to a user account that can log in. To change root to a user,

type the following command in a terminal window:

# rolemod -K type=normal root

This command cannot succeed if the root role is still assigned to a user.
■ If you forget the local user name or password that you entered during the installation, boot

the system in maintenance mode, as described in “How to Troubleshoot Your Login” on
page 72.

Assigning Roles to User Accounts
Roles can be assigned to users only.

■ To determine which roles are assigned to your user account, open a terminal window and
type:

$ roles

root

■ To assign an existing role to a user, use the usermod command.

# usermod -R zfssnap username
■ To create and assign a role to a user, use the roleadd command to create the role, and the

usermod command to assign the role to a user.
To create a role, use either of the following two methods:

# roleadd -K profiles="System Administrator" sysadmin

# roleadd sysadmin

# rolemod -P "System Administrator" sysadmin

To assign the role:

# usermod -R zfssnap,sysadmin username

For more informations, see Chapter 8, “Using Roles and Privileges (Overview),” in System
Administration Guide: Security Services.

Assigning Roles to User Accounts

Chapter 5 • Understanding Users and Roles 53

http://www.oracle.com/pls/topic/lookup?ctx=821-1456&id=prbac-1
http://www.oracle.com/pls/topic/lookup?ctx=821-1456&id=prbac-1


Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find out more about configuring and using
RBAC.

“Configuring and Using RBAC” in System Administration
Guide: Security Services

Find system administration tasks for setting up
and managing user accounts and groups.

Chapter 1, “Managing User Accounts and Groups
(Overview),” in System Administration Guide: Basic
Administration

Related Information
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Managing System Services

In Oracle Solaris, services are managed exclusively by the Service Management Facility. This
chapter provides basic instructions for identifying which services are enabled or disabled on
your system and how to start and stop SMF services.

Managing Services on Your System
UNIX operating systems traditionally include a set of services or software programs that are not
associated with any interactive user login. SMF provides an infrastructure that augments the
traditional UNIX startup scripts, init run levels, configuration files, as well as other services and
software programs.

Services listen for and respond to requests to perform certain tasks, for example:
■ Delivering mail
■ Responding to FTP requests
■ Permitting remote command execution

SMF simplifies the management of these system services, by creating a supported, unified
model for services and service management on each Oracle Solaris system.

The fundamental unit of administration in the SMF framework is the service instance. Each
service instance is named with a Fault Management Resource Identifier (FMRI). The FMRI
includes the service name and the instance name. For example, the FMRI for the sendmail
service is svc:/network/smtp:sendmail, where network/smtp identifies the service and
sendmail identifies the service instance.

Examples of other acceptable FMRIs include the following:
■ svc://localhost/system/system-log:default

■ svc:/system/system-log:default

■ system/system-log:default

Services can be enabled from the GNOME desktop or by using the command line.
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For more information, see the smf(5) man page.

Enabling Services From the Desktop
You can enable and disable some services that are installed on a system by using the Services
application that is located in the GNOME desktop. Enabling and disabling services by using the
Services application is equivalent to using the svcadm command.

The services that can be viewed and managed from the desktop depend on the authorizations
that are assigned to the user account and the service itself.

▼ How to Enable SMF Services From the Desktop
To enable SMF services from the GNOME desktop, follow these steps:

Choose System → Administration → Services.
The SMF Services window open, with the Enabled instances option (in the left pane) selected.
The number of service instances that are enabled is also displayed. In the State column all
enabled services are displayed as “online”.

■ To view all service instances and their statuses, click the All instances option in the left pane
of the SMF Services window.
In this view, all service instances are listed. Online services are listed first, followed by offline
and disabled services.

■ To view unhealthy service instances, click the Unhealthy instances option in the left pane of
the SMF Services window.

To disable or enable a service instance, do the following:

■ To disable a service instance:

a. With the Enabled instances option selected, from the list of services that is displayed,
locate the service to disable.

■ To search for the service, type the name (or part of the name) of the service in the
Filter field at the top of the SMF Services window.

b. Click the Disable button.
A message alerting you that the service has been disabled is displayed. Also displayed are
instructions on how to enable the service from the command line.
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■ To enable a service instance, do the following:

a. Click the All instances option in the left pane of the SMF Services window.

b. From the list of disabled services, locate the service to enable, then click the Enable
button.

The service state transitions from disabled to offline, and eventually to an online state.

■ If the service instance does not transition to an online state within a few seconds,
click the Enabled instances option and search for the service instance.

The State column for the service should now display the service as “online.

Caution – Do not randomly disable or enable services from the desktop. Doing so can prevent a
system from booting.

Enabling Services From the Command Line
The svcs command is used to identify which services are installed on a system. The svcadm
command is used to administer or change the state of a service. To configure SMF services, you
must assume a role with appropriate privileges, such as the root role.

For more information, see the svcs(1) and svcadm(1M) man pages.

▼ How to List the Services on an Installed System
Open a terminal window.

To list all of the services that are installed and enabled on a system, type:
$ svcs

■ To list all of the services that are installed on the system, and the status of each service, use
the svcs command with the -a option.

$ svcs -a

This command displays all of the services, including those that are disabled.
■ To display the status of a specific service, use the svcs command with the -l option.

$ svcs -l FMRI
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▼ How to Start a Service
If a program is managed by SMF, use the svcadm command to start it.

Open a terminal window.

Type the command to start the service.
$ svcadm enable FMRI

Verify that the service is running.
$ svcs -a | grep FMRI

▼ How to Stop a Service
Open a terminal window.

Type the command to stop the service.
$ svcadm disable FMRI

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find overview information about SMF. Chapter 11, “Managing Services (Overview),” in System
Administration Guide: Basic Administration

Find instructions on managing services by using
SMF.

Chapter 12, “Managing Services (Tasks),” in System
Administration Guide: Basic Administration
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Setting Up Your Application Development
Environment

Oracle Solaris provides flexibility and scalability for setting up a development environment that
targets multiple platforms. This chapter describes the tools that are available for developing
your application environment.

Installing Developer Tools
Oracle Solaris enables you to build applications and solutions in a variety of programming
languages, including: C/C++, Java, PHP, Python, and Ruby.

You can download and install developer tools from IPS package repositories by using Package
Manager or by using pkg commands.

If a tool is not available from an IPS package repository, you can download the tool directly
from the product site. However, if the tool is available in an IPS package repository, obtain the
tool from the repository and not from another site. The tool that is in the repository might be
specifically configured for use with Oracle Solaris.

Available Developer Tools
Following are some of the Oracle Solaris developer tools that are available from the IPS package
repositories:

■ Apache Web Server
■ Bluefish HTML editor
■ Oracle Solaris DTrace Toolkit
■ Eclipse
■ GCC runtime libraries
■ gedit

■ High Performance Computing
■ Java Development Kit (JDK)
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■ Lighttpd Web Server
■ memcached distributed object caching framework
■ Miscellaneous tools, for example the make utility
■ MySQL Database Server
■ NetBeans
■ Oracle Solaris Modular Debugger
■ Oracle Solaris Studio Development IDE for C/C++ and Fortran
■ Oracle Solaris Workshop Compilers Bundled libC
■ Perl
■ PHP
■ PostgreSQL
■ Python
■ Ruby
■ Squid Web Proxy Cache
■ Tomcat
■ Web Stack

Related Information
For more information about these and other developer tools, go to http://www.oracle.com/

technetwork/index.html.

Related Information
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Keeping Your System Up-To-Date

After you have installed Oracle Solaris, you can add, remove, and update packages on your
system. You can update individual packages, or you can update all of those packages in an
image that have updates available by using either the IPS GUI tools (Package Manager and
Update Manager) or the IPS CLI.

Updating Software Packages on Your System
To keep your system up-to-date, you can update all of the packages on your system that have
available updates. This action updates packages that you might not otherwise consider
updating, for example, kernel components or other low-level system packages.

To display a list of all of the packages on your system that have available updates, use one of the
following methods:
■ In Package Manager, follow these steps:

1. Choose Updates from the View menu.
2. Choose All Publishers from the Publishers menu.
3. From the list of packages that is displayed, click the Install/Update button or choose

Package → Install/Update.
To select all of the packages that are listed, click the selection icon in the column heading
or choose the Edit → Select All option.

■ In Package Manger, click the Updates button or choose Updates from the Package menu.
The Updates window lists all of the packages that will be updated and gives you an
opportunity to cancel or proceed with the updates.

■ From the GNOME desktop menu, choose System → Administration → Update Manager.
The Update Manager window lists all of the packages that will be updated and gives you an
opportunity to cancel or proceed with the updates.

■ To list packages with available updates, type the following command:
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$ pkg list -u

■ To update an image, type the following command:

# pkg update --accept

This command updates all of the installed packages in the current image to the newest
version available and allowed. If a license agreement is required, the license agreement is
accepted and the update continues. If you do not specify the --accept option, and one
package requires you to accept its license, then no packages are updated.

■ To display the packages to be updated, without actually installing them, type the
following command:

# pkg update -nv --accept

When certain key packages are updated, for example, some drivers and other kernel
components, the system performs the following actions:

1. Creates a clone of the current boot environment (BE) that is a bootable image.
2. Updates the packages in the clone, but does not update any packages in the current BE.
3. Sets the new BE as the default boot choice the next time the system is booted. The current BE

remains as an alternate boot choice.

Use the beadm command to create, rename, mount, unmount, activate, or destroy BEs. You can
use the Package Manager to activate, rename, and delete BEs.

For more information, see “Related Information” on page 64.

Updating Individual Software Packages on Your System by
Using pkgCommands

To update individual software packages on your system, use the pkg install command. You
can also use Package Manager to update a specific package on your system. Any dependent
packages are also updated at the same time.

For more information, see the pkg(1) man page.

Managing Multiple Boot Environments
A boot environment, also called a BE, is a bootable instance of the Oracle Solaris operating
system image, plus any other application software packages that are installed on that image.
You can maintain multiple boot environments on a single system, and each boot environment
can have a different software version installed.

Updating Individual Software Packages on Your System by Using pkg Commands
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Upon the initial installation of the operating system, a boot environment is created on your
system. Use the Boot Environment Management tool or the beadm command to administer
additional boot environments on your system.

Why Use Multiple Boot Environments?
With multiple boot environments, the process of updating software becomes a low risk
operation because you are able to create backup boot environments before making any software
updates to your system. If necessary, you have can boot a backup BE.

Note – The process of creating backup boot environments does not create a backup of all the files
on your system and is not the same as backing up a file system.

The ability to create different boot environments enables you to have different environments
for different versions of tools that you use. Shared files are not affected by creating a new boot
environment. If you modify files in a newer boot environment, and then boot to an older boot
environment, the files are also modified for that boot environment. You cannot retrieve an
older version of a shared file from an older boot environment.

You can maintain more than one boot environment on your system at the same time and
perform various upgrades on each of them. For example, you can clone a boot environment by
using the beadm create command. A clone is a bootable copy of a boot environment. Then,
you can install, test, and update different software packages on the original boot environment
and on its clone.

Although only one boot environment can be active at any given time, you can mount an
inactive boot environment by using the beadm mount command. Then you can use the pkg
update command to update all of the packages in that inactive, mounted environment that have
available updates. Or, use the pkg install package-name command, with the -R option to
update specific packages in that boot environment.

Managing Boot Environments by Using Package
Manager
You can use Package Manager to manage your boot environments.

The following boot environment management tasks can be performed by using Package
Manager:

■ Display information about all of the boot environments on your installed system
■ Delete old or unused boot environments
■ Change the default boot environment on your system

Managing Multiple Boot Environments
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■ Activate a boot environment

Note – Using Package Manager to manage your boot environments from the desktop does not
provide all of the options for managing your boot environments that are available by using the
beadm command. For more information, see the beadm(1M) man page.

▼ How to Manage Boot Environments From the Desktop

Start Package Manager by choosing System → Administration → Package Manager, or by
clicking the Package Manager icon that is located on the desktop.

Choose File→ Manage Boot Environments.
The Boot Environment Management window opens, displaying all of the available boot
environments that are on your installed system. Also displayed is the name of the operating
system, the date the boot environment was created, and the size of the boot environment, in GB.

■ To delete a boot environment, click Delete, then click OK.

■ To change the default boot environment, place a check mark next to the new default boot
environment, then click OK.

■ To activate a new boot environment, click Active on Reboot, then click OK.
The new boot environment becomes active on the next system reboot.

Related Information
For more information, see the following additional resources.

Topic Where To Find More Information

Find out more about keeping your system
up-to-date by using Package Manager.

Oracle Solaris 11 Express Image Packaging System Guide

See the Package Manager online help

Find our more about using Update Manager. “Using Update Manager” in Oracle Solaris 11 Express Image
Packaging System Guide

Find out more about managing boot
environments.

Managing Boot Environments With Oracle Solaris 11 Express
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Managing the GRUB Menu in the Oracle Solaris
Release

When you boot an x86 based system, the GRUB menu is displayed. This menu reflects the
contents of the currently active menu.lst configuration file on the system. A boot entry for
every OS instance that is installed on your system is listed.

When you install Oracle Solaris, or any new operating system, the bootadm command
automatically updates the menu.lst file, adding an entry for the newly installed operating
system. However, in certain cases, for example, if you previously installed Linux, the GRUB
menu is not automatically updated after an installation to include the Linux entry from a
previous installation.

Adding a Linux OS Entry From a Previous Installation to the
GRUB Menu

If you are setting up a boot environment in such a way that you install Linux on one partition
first and Oracle Solaris on another partition afterwards, you will need to follow special
instructions to ensure that the GRUB menu information from the new installation does not
erase the GRUB menu information from a previous installation. The following procedure
describes how to manually update the menu.lst file to include a Linux entry from a previous
installation.

▼ How to Add a Linux Entry to the GRUB Menu After
Installing Oracle Solaris
These instructions assume that you have already installed Linux on your system, and then you
installed Oracle Solaris.
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Note – Instructions for installing the Linux operating system are not included in this task.

At the completion of the Linux installation, copy the active menu.lstfile to a USB drive, so you
can reuse the information after you have completed the Oracle Solaris installation.

Typically, this file is /boot/grub/menu.lst.

■ If you are unsure about the location of the active menu.lstfile, use the bootadm command to
locate the file:
# bootadm list-menu

■ If you are unsure about the location of the USB drive, use the mount command, with no
options, to determine where the USB drive is mounted. Then, copy the menu.listfile to that
location.

After the installation has completed, edit the active menu.lstfile, as follows:

a. Open a terminal window and assume the root role or become the rootuser.
$ su root

Password:

b. Using a text editor, edit the menu.lstfile.

For example:
# vi /pool-name/boot/grub/menu.lst

c. Using the USB drive that you copied the menu.lstfile to in Step 1, copy the Linux menu.lst
information from the original Linux installation to the end of new menu.lstfile.

For example, the menu.lst file from an Ubuntu installation would look similar to the
following:
title Ubuntu 8.04, kernel 2.6.24-18-generic

root (hd0,4)

kernel /vmlinuz-2.6.24-18-generic \

root=UUID=1ed7fa17-6d77-4b49-be1a-22481310fd1b ro quiet splash

initrd /initrd.img-2.6.24-18-generic

quiet

title Ubuntu 8.04, kernel 2.6.24-18-generic (recovery mode)

root (hd0,4)

kernel /vmlinuz-2.6.24-18-generic \

root=UUID=1ed7fa17-6d77-4b49-be1a-22481310fd1b ro single

initrd /initrd.img-2.6.24-18-generic
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Caution – Do not directly edit the original contents of the menu.lst file. Always add new
information to the end of the file, or make changes by duplicating the existing content, then
modify that content.

d. Save and exit the file.

Reboot the system.
When the system reboots, the GRUB menu should include entries for both the Linux and
Oracle Solaris operating systems.
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Troubleshooting the Oracle Solaris 11 Express
Release

This chapter provides troubleshooting information for some common problems that you might
encounter when installing or using Oracle Solaris 11 Express.

If you encounter a problem, do the following:

■ Review the troubleshooting information in this appendix.
■ Review the Oracle Solaris 11 Express Release Notes .

Tips on Troubleshooting an Oracle Solaris Startup
Use the following information to help you troubleshoot potential startup issues.

What to Do If Your System Boots in Console Mode
If your system's graphics card is not supported by the live CD, or your system does not have a
graphics card, the system boots in console mode when you insert the live CD. In this case, you
cannot perform a GUI installation.

Your two alternatives are as follows:

■ Use the text installer image instead of the live CD ISO image.
You can run the text installer on the local console without network access. To download the
text installer image, go to http://www.oracle.com/

technetwork/server-storage/solaris11/downloads/index.html.
■ Perform a remote installation.

If you use this option, you do not need to download the text installer image. However, note
that this option requires remote ssh access and a target system that has an X server running.
For instructions, see “How to Install Oracle Solaris From the Live CD If Your System Boots
in Console Mode” on page 71.
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▼ How to Add Additional Software Packages After an Installation With
the Oracle Solaris Text Installer
If you use the text installer, your installed system does not include all of the software packages
that are included in a live CD installation. In particular, the installed system does not include
the GNOME desktop. If you want your system to contain all of the software packages that are
included in a live CD installation, including the GNOME desktop, use the following procedure
to add the necessary additional packages to your installed system.

Note – To perform the following procedure, your system must have network access, so that you
can download software packages from an IPS networked repository.

Assume the root role or become the rootuser.
$ su -

password:

#

Create a new boot environment (BE) to install the additional packages.
# beadm create be-name

Note – By creating a new BE and installing the additional packages there, you retain your
originally installed system and can revert back to it, if necessary.

Mount the newly created BE on the temporary mount point, /tmp/a.
# beadm mount be-name /tmp/a

Add the slim_install software package to the new BE.
# pkg -R /tmp/a install slim_install

The slim_install package is a large group of packages that includes specific packages for the
GNOME desktop.

Remove the software package.
# pkg -R /tmp/a uninstall slim_install

Note – The slim_install package is a group package. Removing the slim_install group
container enables you to individually manage all of the packages that were installed as part of
that group.

Update the boot archive on the new BE.
# bootadm boot-archive -R /tmp/a
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Unmount the newly created BE.
# beadm unmount be-name

Activate the new BE.
# beadm activate be-name

Reboot the system.
# reboot

▼ How to Install Oracle Solaris From the Live CD If Your
System Boots in Console Mode
For this procedure, two networked systems are required: the system on which the live CD was
booted (target system) and a remote system, from which the installation will be performed.
Both systems must have network access. It is not required that the two systems be on the same
subnet. However, the target system must be reachable from the remote system. Also, the remote
system must be running an OS that supports a graphical desktop.

On the system to be installed, insert the Live CD, then boot the system.

At the console login, type the default login and password.
The default user login and password for Oracle Solaris is jack.

Become the rootuser.
$ su root

Password: solaris

The root password is solaris.

Enable the service for the ssh remote login program.
# svcadm enable ssh

Display the IP address that is assigned by DHCP to the target system.
# ifconfig -a

On the remote system, open a terminal window, then type:
$ ssh -X ip-address-of-target -l jack

where ip-address-of-target is the output of the ifconfig -a command that you ran on the target
system.

Running this command on the remote system opens a secure shell, enabling you to access the
target system to use the GUI installer.

7

8

9

Before You Begin

1

2

3

4

5

6

Tips on Troubleshooting an Oracle Solaris Startup

Appendix B • Troubleshooting the Oracle Solaris 11 Express Release 71



Become the rootuser.
$ su root

Password: solaris

Run the GUI installer:
# /bin/gui-install

After the installation completes, reboot the target system.

How to Monitor the Live CD Startup Process
You can switch from the default graphical boot screen to the text boot screen. The ability to
switch to the text boot screen can be useful if you suspect that the system startup process is not
proceeding normally. The text screen might contain informational messages or a request for
user input. Switching to the text boot screen has no impact on the boot sequence, other than
how the information is displayed on the screen. Initialization of the operating system continues
and completes as normal.

To switch to a text boot, press any key a few seconds after the graphical boot screen appears, and
the progress bar starts.

Note – After switching from the graphical boot to a text boot, there is no way to switch back to
the graphical boot screen.

Troubleshooting Login and User Account Issues
If you are unable to log in to your installed system, use the following procedure.

▼ How to Troubleshoot Your Login
Troubleshooting login issues requires you to gain access to the system by booting in single-user
mode, so you can troubleshoot the nature of problem and apply the appropriate solution. This
procedure includes the steps for booting a system in single-user mode, as well as solutions to the
some of the more common login problems.

Boot the system in single-user mode.

a. When the boot sequence starts, and the GRUB menu is displayed, type e to edit the GRUB
menu entries.

b. Using the up or down arrow keys, select the kernel$ line, then type e to edit that entry.
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c. Type an -s after the kernel$ entry.

d. Press Return (or Enter) to go back to the previous screen.

e. To boot the system in single-user mode, type b.

When prompted, type a user account name.
The account name can be root, or any other privileged account, such as jack on the live CD
ISO image, or an account that you created during the installation.

Type the rootpassword.
After the system has booted, depending on your particular situation, you can do any of the
following:

■ Display the existing user accounts and roles:
-bash-3.2# cat /etc/user_attr

■ Delete a user account:
-bash-3.2# userdel username

■ Create a new user account:
-bash-3.2# useradd username

a. Assign a password for the user name.
-bash-3.2# passwd username

Note – You will need to type the password twice.

b. Assign the root role to that user.
-bash-3.2# usermod -R root username

To return to the installed system, type exit.
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locating information about, 24–28
using Device Driver Utility, 24–28
using Oracle Device Detection tool, 24–28

disabling services, by using SMF, 56–57
drivers, locating, 24–28

E
enabling services

by using SMF, 56–57
guidelines, 56–57
in the desktop, 56–57

G
getting additional software, 44–46
graphics card, troubleshooting unsupported, 69–71

75



GRUB menu entries, preserving Linux information, 65
GRUB menu issues, troubleshooting missing

entries, 65–67

H
how to list services, using the svcs command, 57
how to start a service, from the command line, 58

I
individual packages, updating, 62
installation considerations, 16–17
installation of Oracle Solaris, preparing for, 22–23
installation problems, booting in console mode, 69–71
installation requirement, 16
installing developer tools, 59–60
installing Oracle Solaris, options, 15
installing Oracle Solaris in a virtual machine, preparing

for, 24
installing remotely, system boots in console

mode, 71–72
installing VirtualBox

on Linux, 36–37
on Windows or Mac OS X, 36

L
limitations, when installing, 16–17
Linux, installing VirtualBox, 36–37
Linux menu entry, updating menu.lst file, 65
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